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Objective

Introduction

The purpose of this document is to record the steps required to configure a NetScaler Gateway for use with StoreFront and
XenDesktop.

Particular attention has been paid to the use of on-board NetScaler tools for creating a server certificate for the NetScaler Gateway.
It will be seen that the NetScaler is using an exported root CA from a Microsoft Certificate Server so that client systems only need a
single CA certificate.

The target audience for this document includes developers and testers who wish to set up a representative environment for testing
external access scenarios.

While this document only attempts to record a single configuration, it is hoped that it will act as a stepping stone for those who
wish to create similar or more advanced configurations.

Instructions
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o Create a NetScaler Gateway Virtual Server

¢ StoreFront
e DNS

 StoreFront - Configuring a new installation

o Test the deployment from a Windows PC connected to the Internet
e On the Windows PC

Network Diagram

External IP Address

192.168.18.22
[192.168.18.20]
152.168.18.1 [192.168.18:21] c‘TR!x’

f———ec——i

Firewall Netscaler Gateway
152.168.80.100 (Netscaler 10.n)

&

192.168.80.(DHCP)

( Private Internal LAN i)
192.168.80.83 192.168.80.7 192.168.80.6 192.168.80.5 192.168.80.(OHCP) 192.168.80.23
VirtDco1 '
Domain XenApp07 i AppCOB X XenDDC23
Controller Citrix i_AppController | Receiver XenWin8x Desktop
DNS XenApp Storefront Virtual Delivery
DHCP Server server Desktops Controller
TS Licenses

The NetScaler will use the following network addresses
NetScaler IP Subnet IP Virtual IP
192.168.18.20 192.168.18.21 192.168.18.22

Back to top

NetScaler Configuration

This section assumes that you will be creating a NetScaler VPX virtual appliance and hosting it on XenServer.

The processes for configuring a physical NetScaler appliance, or a NetScaler VPX virtual appliance hosted on another Hypervisor is
similar.

Back to top

Initial setup from XenCenter Console

1. Download the latest NetScaler VPX virtual appliance from www.citrix.com and import it into XenServer.

2. Using XenCenter, start the new NetScaler VM and go to the VM console.

*There is no ns.conf in the snsconfig?

itart Netscaler software

tput: no terminal type specified and no TERM environmental variable.
inter NetScaler’'s ss [1: 192.168.18.20

inter Netmask [1: )& C

nter Gateway IPv4 addr : 192.168.18.1

etscaler Virtual Appliance Initial Network Address Configuratiom.

[his menu allows you to set and modify the initial IPv4 network addresses
The current value is displayed in brackets ([1).

selecting the listed number allows the address to be changed.

ifter the network changes are saved, you may either login as nsroot and
1se the Ne aler command line interface, or use a web browser to
ittp:rr198 68.18.20 to |||mplz'1|' or change the Netscaler |\n|l'l[_\llr-.ltilln,

1. NetScaler' 55 [192.168.18.201

; [192.168.18.1 )

3. Enter the following information into the first time wizard.
IPv4 address Netmask Default Gateway
192.168.18.20 255.255.255.0 192.168.18.1
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4. Select 4 to Save and quit. The NetScaler will reboot.

Back to top

Continue setup from NetScaler GUI

1. From a convenient PC, workstation, or server, launch a browser and point to http://192.168.18.20

2. Log on using the following credentials: Username nsroot Password nsroot

Welcome!

% Use this wizard for initial configuration of your NetScaler virtual appliance. To configure or to change a previously configured setting, click each of the sections

below. If a parameter has already been configured, a check mark appears within a green circle. An orange circle containing a dash indicates that you have chosen to
skip this section.

NetScaler IP Address
e 1P ade hich you ace

Q NetSc

C P Address Netmask °
192.168.18.20 255.255.255.0

Subnet IP Address

ess the NetScaler for configuration, monitoring, and other manager

- Specify an IP address for your NetScaler to communicate with the backend servers.
- Y ¥

The NetScaler “Welcome Wizard” now walks you through the configuration of the Subnet IP Address, Host Name, DNS details,
Time Zone and Licenses

https://support.citrix.com/article/CTX200287
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Dashboard

Subnet IP Address

A subnet |P address is used by the
NetScaler to communicate with the
backend servers, NetScaler uses this subnet
IP address as a source IP address to proxy
the client connections as well as to send
monitor probes to check the health of the
backend servers,

The infographic shows the usage of SNIP in
client server communication.

Depending on your network topology, you
might have to configure additional subnet
IP addresses.

For more information about subnet IP
addresses, click here,

% Subnet IP Address®
|192 . les . 18 ., 21
Metmask®
|255 255 ., 255 . O

Dashboard Configuration Reporting

Client requests arrive at the
vIP

Source IP = Client IP
Destinaton 1P = VIE

Request

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

NetScaler opens a
connection and forwards
the requaest to the sarver

Source IP = SNIP
Destination [ = Server IP

Response
Chent

MetScaler forwards the
response o the chent

Source IP = VIP
Desination IP = Client IP

VIP = Virtual [P address
SNIP = Subnet IP address

[
Request .
ol = =
-—

Response

Server
Server sends the response
o NetScaler

Source IP = Server IP
Destination IP = SNIP

Documentation Downloads #

g Host Name, DNS IP Address, and Time Zone
r——

Specify a host name to identify your NetScaler. When you generate the Universal license for NetScaler Gateway, the host name s used in the license.
Specify the IP address of a DNS server if you want to allocate your licenses from the Citrix licensing portal. Specify the time zone in which your
MNetScaler is located.

Host Name
nstestgw

DNS IP Address

‘192 . 168 . 80 . 1 “F

Time Zone*

M +00:00-GMT-Europ eILom‘.bl

—
o

Dashboard Configuration Reporting Documentation Downloads 'n'

% 1 Licenses Updated Successfully

Licenses

If a license is already present on your local computer, you can upload it to this NetScaler. Alternatively, you can use the serial number of this NetScaler or
the license activation code (sent through email by Citrix) to allocate licenses from the Citrix licensing portal.

The following license files are present on this NetScaler. Select Add New License to upload more licenses. To delete 3 license, select the license and click Delete. Restart the

NetScaler for the licenses to be effective.

Add New License |

CNS_VS00_SERVER_PLT_Retailic

CAG_PLATFORM_RETAIL_720GP_15A_50CCU(Retail 4)lic

Retail-CAGU-5000CCUlic

Reboot later

3. Add your licenses (the preceding are Citrix test licenses. Your experience will probably differ).

4. Click Reboot.

Dashboard Configuration Reporting

Documentation Downloads

+ System NetScaler > Traffic Management

+ AppExpert

Citrix ShareFile
Setup NetScaler for ShareFile

— Traffic Management

+ Load Balancing

+ Content Switching

+ Cache Redirection
+ DNs

+ Gsts

+ss1

+ Optimization
=+ Security
+ NetScaler Gateway Q@

Show Unlicensed Features

Remove ShareFile Configuration

o 0

Monitor Sessions
Virtual Server persistence sessions

Clear persistence sessions

5. After logging back in to the GUI it can be seen that some features are disabled by default.

https://support.citrix.com/article/CTX200287
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6. Enable NetScaler Gateway and SSL by selecting the feature, and using right-click and Enable.

== NetScaler VPX (500)

[%— System MetScaler > System 3 User Administration > Users (] [7] E

Add Edit Change Passwor d Search =

Diagnastics User Name CLI Prompt Prompt inherited from Idle Session Timeout (secs) Idle Session Timeout inherited fro

High Availability nsroot - - 900  Global
NTP Servers

Reports
Profiles
= User Administration
Groups
Users
Database Users

Command Policies

7. You might need to change the nsroot password.

Back to top

Server Certificates, CA Certificates, and SSL

The System 3 test team try to build environments which reflect real world cases and generally server certificates are created for all
servers, and use SSL to communicate whenever possible. To create these certificates, engineers use their Microsoft Certificate Server,
rather than using public Certificate Authorities which would be expensive for multiple test environments. Because they do not use
one of the well-known public Certificate Authorities, they have to ensure that they are installed on trusted CA certificate on all client
devices.

Because the Microsoft Certificate Server is known to Active Directory the trusted CA certificate is automatically installed on all
domain-joined systems. The engineers then have to manually add the trusted CA certificate to non-domain-joined systems
including domestic PCs, thin clients, tablets and smart phones.

This section describes how to create server certificates for NetScaler Gateways using the tools on the NetScaler appliance. It will be
seen that the NetScaler is using an exported root CA from our Microsoft Certificate Server so that we do not have to distribute
additional CA certificates to our client systems.

Back to top

On the Microsoft Certificate Server
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1. Run mmc and load the Certification Authority Snap-in.

= Console1 - [Console Root\Certification Authority (Local)]
@ File Action View Favorites Window Help

e 2@ = HE > -

] Console Root Name Description

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ns:
Snap-in Vendor [~ Console Root Edit Extensions...
E Active Directory Do... Microsoft Cor... Certification Authority (Local)

EAcﬁve Directory Sch... Microsoft Cor... _

[iF Active Directory Site... Microsoft Cor...

3 Active Directory Use... Microsoft Cor...
' ActiveX Control

Microsoft Cor...
2’ ADST Edit Microsoft Cor...
Authorization Manager Microsoft Cor...
& certificate Templates  Micrasoft Cor...
@l Certificates Microsoft Cor...
Ll Certification Autharity Microsoft Cor...
. Component Services  Microsoft Cor...
@ Computer Managem... Microsoft Cor...
ﬂ Device Manager Microsoft Cor...
¥ pHep Microsoft Cor...

Description:
Allows you to configure certification authority properties and to manage certificates issued by this CA.

File Action View Favorites Window Help

e nE HDaz HE » -

] Console Root Name
4 7 Certification Authority (Local) (=] Revoked Certificates
4 E virtdom-VIRTDCO e N —
| Revoked Ceni‘l‘ as ? EI’VIVCE
[ lIssued Certific View > Stop Service
[ Pending Requ New Window from Here Submit new request...
7 Failed Request
= Certificate Ter New Taskpad View... Back up CA...
Refresh Restore CA...
Export List... Renew CA Certificate...
Properties
Help

2. Right click the authority > All Tasks > Back up CA.

@ Console1 - [Console Root\Certification Authority (Local)\virtdom-VIRTDCO1-CA]
File Action View Favorites Window Help

e 2EEBcz HE » »

] Console Root Name
4 ﬁ Certification Authority (Local) || Revoked Certificates
4 g virtdom-VIRTDCO1-CA " Issued Certificates
7| Revoked Certificates | Pending Requests

lems to Back Up = },
You can back up individual components of the certffication authority data. @J‘

Select the tems you wish to back up:
[ Private key and CA certificate

[~ Certificate database and certificate database log
I Perform incremental backup

Back up to this location:
C:\Download\
Note: The backup directory must be empty.

3. Back up the Private key and CA certificate to a convenient location.
4. Create a password.

5. Click Next.

(& Callor Chat

https://support.citrix.com/article/CTX200287
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6. Click Finish.

ﬁ Console1 - [Console Root\Certification Authority (Local\virtdom-VIRTDCO1-CA]
E File Action View Favorites Window Help
o = )=y b w

[ 2] Console Root Name
4 5 Ceutification Authority (Local) [ Revoked Certificates
4 itdom-VIRTDCO1-CA [ Issued Certificates

The backup creates a .p12 file with the name of your Certificate authority.

| Revoked Certificates " Pending Requests

For encryption and decryption of messages. both a public key and a private key
are required. You must supply a password for the private key.

This password is required to gain access to the private key and the CA cerfficate file.

Password:

I

Corfirm password:

To maintain private key security, do not share your password.

Home

Share View Search

CEOREIIN

» ThisPC » Local Disk (C:) » Download »

7 Favorites
B Desktop
8 Downloads
“'E Recent places

% This PC
™ Desktop
jﬂ Documents
8 Downloads
i Music
£ Pictures
B Videos
i, Local Disk (C:)

e‘- Network

Back to top

Name Date modified

virtdom-VIRTDCO1-CA.p12 05/09/2014 10:50
B - o 19/06/2014 15:52
19/06/2014 15:11
19/06/2014 14:54
19/06/2014 14:14
13/06/2014 12:54
13/06/2014 12:53
12/06/2014 16:47
12/06/2014 16:01
13/05/2014 15:51
13/05/2014 15:18
06/05/2014 11:58
2eg 02/05/201411:00
23/04/201411:09

A IAAMAT 8 TN

On the NetScaler GUI

To import the backed up key and certificate, complete the following steps:

https://support.citrix.com/article/CTX200287

Type

Personal Informati...

REQ File
REQFile
Security Certificate
Security Certificate
Security Certificate
Security Certificate
REQ File
Security Certificate
Security Certificate
REQ File
Windows Powers...
Registration Entries
REQ File

L ey S,

Size

3KB
1KB
1KB
2KB
2KB
2KB
TKB
TKB
2KB
2KB
2KB
1KB
1KB
1KB

S wn

(2 CallorChat
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1. Go to Traffic Management > SSL > Tools > Import PKCS#12.

22 NetScaler VX (500)

Dashboard Configuration Reporting

* System NetScaler »
s AppExpert

=/ Traffic Management

* Load Balancing n
*- Content Switching
* Cache Redirection D
+- DNS

¥ GSLB 1]

SSL Keys
Create RSA Ke
Create DSA Ke

+ SSL
* Optimization
* Security
s MetSealer Gateway

Show Unlicensed Features

22 NetScaler VPX (500)

Dashboard Configuration Reporting

4 Back

Import PKCS12 File

Output File Name*

VirtdomKeyAndCApem Browse -
Appliance
PKC512 File®
virtdom-VIRTDCO1-CA.p12 Browse x|
Local v
Impeort Password™
Appliance
LTI

Encoding Format

2. Output file name is xxxxx.pem in the /flash/nsconfig/ssl folder on the appliance. PKCS12 File is the p12 backup file created.

Traffic Management > SSL

Getting Starte

Wizard

Y
Y

N510.5 50.10.n¢ T Laguut

Documentation Downloads

SSL Certificates

Create CSR (Certificate Signing Request)

Create and Install a Server Test Certificate

Tools

Create Diffie-Hellman (DH) key
Imp KCS#12
Export PKCS#12

NS10.5 50.10.nc et

Documentation Downloads

Password is the password used during the backup

Notes:

Create the server certificate

To create the server certificate, complete the following steps:

» By using the dropdown arrows next to the browse buttons, it is possible to read the .p12 file from the local PC/Server where you
did the Backup, and output the new .pem file to NetScaler appliance.

o The .pem file output by this process will contain both the RSA Private Key and the CA Certificate required to create server

certificates on the NetScaler.

https://support.citrix.com/article/CTX200287
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22 NetScaler VX (500)

Dashboard Configuration

* System
* AppExpert
=/ Traffic Management

¢ Load Balancing
* Content Switching
¢ Cache Redirection 0]
# DNS
* GSLB B
* SSL

* Optimization

*i Security

* NetScaler Gateway

Show Unlicensed Features

Dashboard Configuration

4 Back

o

SSL Server Certificate Wizard
1 Create Key

@® RSA (O DSA
Key Filename*
Virtkey.key
Key Size(bits)”
1024
Public Exponent Value®
3
Key Format"
PEM
PEM Encoding Algorithm

PEM Passphrase™

Confirm PEM Passphrase®

e

SSL Server Certificate Wizard

Reporting

NetScaler > Traffic Management > SSL

Getting Started

Server Certificate Wizard

CRL Management

SSL Keys
Create RSA Key
Create DSA Key

Reporting

‘ Browse - |

1 SSL RSA/DSA Keys

Key Type Key Filename

RSA VirtKey.key

2 Create CSR (Certificate Signing Request)

Request File Name*
testgw.req
Key Filename*
VirtKey.key
Key Format*
PEM v

PEM Passphrase (For Encrypted Key)

Distinguished Name Fields
Country*

UNITED KINGDOM ﬂ
State or Province™

Bucks

Organization Name*

Citrix Systems

City

Chalfont

Email Address

X @yyy.com
Organization Unit

System2

Common Name
testgw.hopto.org
Attribute Fields

Challenge Password

Company Name

previous step. Common name is the name that must match the FQDN of the NetScaler Gateway that you will create in a later

‘ Browse -

‘ Browse |v

section of this document.

https://support.citrix.com/article/CTX200287

Logout

Documentation Downloads

SSL Certificates

Create rtificate Signing Request)

Create Cert
Create and Install a Server Test Certificate

Tools
Create Diffie-Hellman (DH) key
Import PKCS#12

Export PKCS#12

cates / Keys / CSRs

cate, key file synchronization for HA

Start SSL certificate, key file synchronization for Cluster

OpenSSL interface

Documentation Downloads

Key Format

PEM Q

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

1. Go to Traffic Management > SSL > Getting Started > Server Certificate Wizard.

e

2. Go to Traffic Management > SSL > Getting Started > Server Certificate Wizard.

3. Create a Certificate Signing Request. Request File Name is a name of your choice. Key Filename is carried forward from the

9/24
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SSL Server Certificate Wizard

1 S5L RSA/DSA Keys

Key Type Key Filename

RSA VirtKey.key

2 SSL Certificate

Request File Name Country
testgw.req UNITED KINGDOM
3 Certificate

Certificate File Name*

testgw.cer Browse |4

Certificate Format*
PEM vl

Auditing Type
Server
Certificate Request File Name*

testgw.req ‘ Browse |w
Key Format®

PEM v
Validity Peried (Mumber of Days)

365

CA Certificate File Name*
/nsconfig/ssl/virtdomKeyAndCA.pem ‘ Browse | -
CA Certificate File format™

PEM v

CA Key File Name®

/msconfig/ssl/virtdomKeyAndCA.pem ‘ Browse -

CA Key File Format*
PEM v

PEM Passphrase (For Encrypted CA Key)

CA Serial File Number*

/nsconfig/ssl/ns-root.srl | Browse | v
[ ]

4. Create the Certificate.

SSL Server Certificate Wizard

1 SSL RSA/DSA Keys
Key Type

RSA

2 SSL Certificate

Request File Name

testgw.req

3 S5L CA Certificate

Key Filename

VirtKey.key

Country

UNITED KINGDOM

Certificate File Name CA Certificate File Name

testgw.cer fnsconfig/ss|/VirtdomKeyAndCA pem

4 Install Certificate
Certificate-Key Pair Name*

% testgw.hopto.org
Certificate File Name™
testgw.cer
Key File Name
VirtKey.key

Password

Certificate Format*
PEM

Certificate Bundle
W] Expiry Monitor

Motification Period

30

—

5. Install the certificate. Important! The GUI also shows a Done button as shown in the following screen shot. Do not click this

‘. Browse -v.|

‘ Browse -v|

before you click Create.

2% NetScaler VPX (500)

Dashboard Configuration

+ Back

& SSL Certificate-Key pair testgw.hopto.org installed successfully

Reporting

SSL Server Certificate Wizard

1 Create Key

2 Create CSR (Certificate Signing Request)
3 Certificate

4 SSL Install Certificate

Certificate-Key Pair Name

testgw.hopto.org

t% Done

https://support.citrix.com/article/CTX200287

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

Key Size(bits)

1024

State or Province

Bucks

State or Province

Bucks

Certificate Request File Name

testgw.req

NS510.5 51.10.nc

Key Format
PEM

Organization Name

Citrix Systems

Key Format

PEM

Organization Name

Citrix Systems

CA Senial File Number

/nsconfig/ssl/ns-root.srl

Logout

Documentation Downloads

Certificate File Name

/nsconfig/ss|/testgw.cer

L
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6. All the steps are complete and click Done. (Optional) Install the CA certificate

Install the CA certificate if you want to use SSL to communicate from the NetScaler Gateway to your StoreFront and XenDesktop

farm.

1. Go to Traffic Management > SSL > Certificates > Install.

2. Browse and select the imported .pem file at Certificate File Name and the Key File Name fields.

3. Click Install.

Install Certificate

Certificate-Key Pair Name™

VirtdomCA

Certificate and Key files are stored in the folder /nsconfig/ssl/ on appliance.
Certificate File Name*

/nsconfig/ss|/VirtdomKeyAndCA.pem | Browse v||1
Key File Name
/nsconfig/ssl/VirtdomKeyAndCA.pem | Browse v|F
Certificate Format
@ pem O DER
Password
] Certificate Bundle
| Notify When Expires

Motification Period

30

Review the installed certificates
1. Go to Traffic Management > SSL > Certificates.

2. Press the refresh icon.

Logout

*% NetScaler VPX (500) N510.5 50.10.nc

Documentation Downloads

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

Dashboard Configuration Reporting

* System NetScaler » Traffic Management > SSL » SSL Certificates
* AppExpert —
Install Action -
= Traffic Management
— Name Days to Expire
+ Load Baldping ®
b ns-server-certificate 4485
- Content Switching @
- Cache Rediraction b testguhopto.org 728
*- DNS p VirtdomCA 2333
< GSLB @
=851
Certificates

Cipher Groups
CRL

Policies

Policy Labels
OCSP Responder

Imports

Back to top

NTP Server

You can use an NTP server to keep time on the NetScaler. SSL is so much easier when all the clocks are in step with each other.

Go to System > NTP Servers > Add.

https://support.citrix.com/article/CTX200287

o

Status

Valid
Valid

Valid

Seart
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4+ Back
Create NTP Server
NTP Server*
’ D.uk.pool.ntp.org|
Minimum Poll Interval
\s
Maximum Poll Interval
’ 10
Auto Key
Key
Create | Close
Back to top

Backups - and why you might want one

The NetScaler appliance now has its network configuration, licences and certificates in place, and the next stage is to run a wizard to

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

create the NetScaler Gateway Virtual Server and its associated elements.

A point to note about the wizard used to establish the NetScaler Gateway Virtual Server is that it is really a series of sub-wizards, and
the NetScaler configuration is updated after each sub-wizard. By having a backup or snapshot at this point one has an option to:

1. Accept the resulting configuration and move forward

2. Rerun parts of the wizard

3. Fall back to this point and start again

First save the configuration by using the Save button at the top right of the GUI.

=2 NetScaler VPX (500)

Dashboard Configuration Reporting

N510.5 51.10.n¢ Logout

Documentation Downloads

= System NetScaler > System > System Information
% Licenses
Settings System Information System Sessions

Diagnostics

High Availability

Upgrade Wizard | |

Statistics

NTP Servers System Information

Reports NetScaler IP Address  192.168.18.2

Profiles
+ User Administration

+ Authentication

+ Auditing

+ sump Last Config Changed Time
+ AppFlow @ Last Config Saved Time
+ Cluster

+ Network

Hardware Information

+ CloudBridge Connector @
+ Web Interface

Backup and Restore

Standalone
GMT+00:00-GMT-Europe/London

Tue, 16 Sep 2014 09

Mon, 15 Sep 2014 14:

Mon, 15 Sep 2014 14:27:53 GMT

NetScaler Virtual Appliance 450000

n  2/17/2009

2261 MHZ

bavcbbasaldf

The NetScaler Backup and Restore tool is at System > Backup and Restore.

https://support.citrix.com/article/CTX200287
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Backup

NetScaler Version

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

NS§10.5: Build 51.10.nc, Date: Aug 14 2014, 04:57:29

File Name*

NS_with_Network_and_Certs

Full

Comment

This backup ....|

1 |

Back to top

Create a NetScaler Gateway Virtual Server

To create a virtual server, complete the following steps:

1. Go to NetScaler > NetScaler Gateway > Integrate with Citrix Products > XenApp and XenDesktop.

2% NetScaler VPX (500)

Dashboard Configuration

+ System

+ AppExpert

+ Traffic Management
+ Optimization

+ Security

+ NetScaler Gateway

Show Unlicensed Features

Integrate with Citrix Products
4 XenMobile

&4 XenApp and XenDesktop

o= NetScaler VPX (500)

Dashboard Configuration

Logout

Reporting Documentation Downloads ﬁ

NetScaler 5 NetScaler Gateway [} o &k
Getting Started Policy Manager

NetScaler Gateway Wizard NetScaler Gateway Policy Manager

Monitor Connections Customize Access Interface

Active user sessions Upload the Access Interface

ICA Connections

Configuration Summary

No MetScaler Gateway Virtual Server
No AAA Group
Mo AAA User

Statistics

Logout

Reporting Documentation Downloads

o
=+ System

+ AppExpert

+ Traffic Management
+ Optimization

+ Security

=+ NetScaler Gateway

Show Unlicensed Features

Integrate with Citrix Products
4 XenMobile

4 XenApp and XenDesktop

https://support.citrix.com/article/CTX200287

NetScaler for

XenApp and XenDesktop

Welcome!

This wizard assists you in setting up NetScaler for XenApp and XenDesktop deployments.

You can use this wizard to configure NetScaler to provide access to hosted virtual desktops (XenDesktop) and hosted Windows virtuz
apps (XenApp) through NetScaler Gateway

Before you Begin

Make sure you have the following information available.
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2. Click Get Started.

Access through NetScaler Gateway

= Public IP address for NetScaler Gateway

= A server certificate for the NetScaler appliance
* LDAP/RADIUS authentication server details
« Fully Qualified Domain Name (FQDN) of Storefront/Web

Interface Server

Optimization Features Overview
* TCP Profile Settings

= S5L Quantum Settings

= HTTP Caching

« HTTP Compression

Get Started

+ Back

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

Load Balance StoreFront/Web Interface/Xen Farm

+ |P address for the load balancing virtual server
« S5L certificate and key pair
= Site Path and PNAgent Site Path

+ Secure Ticket Authority Server

Security and Visibility Overview
+ AppFuw Profile

+ AppFw Policy
+ AppFlow Policy for HDX Insight

XenApp/XenDesktop Setup Wizard

What is your deployment

O Single Hop

Client Internet Access Gatway

What is your Citrix Integration Point?

T |

4. Click Continue.

3. Enter the IP for your NetScaler Gateway Virtual Server.

NetScaler Gateway Settings

Virtual Server Name*®

‘TeSIGW ‘

NetScaler Gateway IP Address*
‘192. e . e . 2

Port”

= |

[ Redirect requests from port 80 to secure port

I

6. Click Continue.

5. Chose the Server Certificate created before.

| ¢ ek

NetScaler Gateway Settings

Name NetScaler Gateway IP Address Port
TestGW 192.168.18.22 443

Server Certificate

® Use existing certificate ' Install Certificate
Server Certificate®

|E|0
Conmiee ]

lt-Bad(

Redirect requests from port 80 to secure port
No

NetScaler Gateway Settings

Name MetScaler Gateway IP Address Port
TestGW 192.168.18.22 443

Server Certificate

testgw.hopto.org

https://support.citrix.com/article/CTX200287

Redirect requests from port 80 to secure port
No

L

Call or Chat
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Authentication Settings

You can configure authentication to allow the NetScaler ADC to serve as a proxy for users who connect with devices through the internal network. You can configure
LDAP and RADIUS servers, and client certificate authentication to provide two-factor authentication. In the case of LDAP authentication, the NetScaler binds to the
LDAP server using the administrator credentials you provide and searches for the user. With RADIUS authentication, a key is used.

Primary authentication method™

Active Directory/LDAP EH

IP Address*

‘192 . 188 . 80 . 1

) Load Balancing
Port™

‘ 389 |
Time out (seconds)*

E |
Base DN*

‘dc:virtdum,dc:chsyﬂ,dc:mm |

Service account®
‘ administrator@virtdom chsys2.com I

[_] Group Extraction
Server Logon Name Attribute™

‘SAMACOOU ntMame I

Password*

Confirm Password*

‘--c-o-u'c-'d 0|0

Secondary authentication method®

None |i|

In this example, users are authenticated against Active Directory. The IP Address 192.168.80.1 is the address of the Domain
Controller.

7. Enter details and click Continue.

|*Bad(

NetScaler Gateway Settings Vs

MName NetScaler Gateway P Address Port Redirect requests from port 80 to secure port
TestGW 192.168.18.22 443 No

Server Certificate Vs

testgw.hopto.org

Authentication Settings Ve

Primary Authentication Secondary Authentication

Active Directory/LDAP: 192.168.80.1_LDAP_pol Not Configured

Storefront

StoreFront FQDN® k

|xenstoreus‘vindom.chsyss.ccm |

Site Path™

|/CilliWStnreWEb |

Single Sign-en Domain®

|V1rtd0m |

Store Name*

| Store |

Secure Ticket Authority Server*

|hi‘tp:ﬁxenapp()?.wrldorn.chsysS‘com | +

Storefront Server®

|192 . 188 . B0 5 |+

Protocol”
| HTTP M|
Port”

[s0 |

Load Balancing

‘ 4 Back
o

NetScaler Gateway Settings Vd
MName NetScaler Gateway IP Address Port Redirect requests from port 80 to secure port
TestGW 192.168.18.22 443 No
Server Certificate Vs
testgw.hopto.org

Q Authentication Settings Vs
Primary Authentication Secondary Authentication
Active Directory/LDAP: 192.168.80.1_LDAP pol Not Configured
Storefront Vs
StoreFront FODN xenstore05.virtdom.chsys3.com Secure Ticket Authority http://xenapp07.virtdom.chsys3.com
Site Path /Citrix/StoreWeb Load Balancing configured No

Single Sign-on Domain  Virtdom

8. Leave Xen Farm > Configure = Blank.

Note: This section relates to load balancing the XenDesktop Controllers and XenApp servers, which is not covered in this
document. However, this sub-wizard can be revisited at any time.

(2 Callor Chat

https://support.citrix.com/article/CTX200287 15/24
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9. Click Continue.

Xen Farm
Configure
™
+ Back

NetScaler Gateway Settings rd
Name NetScaler Gateway IP Address Port Redirect requests from port 80 to secure port
TestGW 192.168.18.22 443 No
Server Certificate rd
testgw.hopto.org

[% Authentication Settings 7
Primary Authentication Secondary Authentication
Active Directory/LDAP: 192.168.80.1_LDAP_pol Not Configured
Storefront Vs
StoreFront FQDN xenstore05.virtdom.chsys3.com Secure Ticket Authority http://xenapp07.virtdom.chsys3.com
Site Path /Citrix/StoreWeb Load Balancing configured  No

Single Sign-on Domain  Virtdom

10. Do not click Apply.
Note: Optimization is not covered by this document. However, this section can be revisited at any time.

11. Review settings and click Done.

Xen Farm V4
XenApp Farm XenDesktop Farm
Not Configured Not Configured

Optimization
Optimize TCP Profile Settings
Optimize 55L Quantum Settings
Apply HTTP Caching
Apply HTTP Compression
e

Apply
Security

Visibility

| Done

A dashboard page is displayed. You can close this and return to the Configuration GUI.

] Citrix NetScaler VPX - Home - Intemnet Explorer - | & s
[ 88 ttpy//192.168.1820/menu/agee?standalone=yes&show,_ftu=no

Universal Licenses HDX Sessions +  Create New NetScaler Gateway

Configured NetScaler Gateway Appliances

Curren it Universal | Licenses Current HDX Sessions
0 0 TestGW
6,000 1

System Information
5,000
4,000 Platform

NetScaler Virtual Appliance 450000
3,000
CPU
2,000 2261 MHZ
1,000 Serial no
0 e a 0 HE2H915CZ6
10:30 1031 10:30 1031
DNS Suffix
CPU Usage Memory Usage Add...

No items
Current CPU Usage Current Memory Usage
0.40% 16.26%
100 100

80 80
&0 60

(Optional) Add the CA certificate to the NetScaler Gateway Virtual Server

If you want to use SSL to communicate from the NetScaler Gateway to StoreFront and XenDesktop, you will need to add the CA

certificate to the NetScaler Gateway Virtual Server.

https://support.citrix.com/article/CTX200287 16/24
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1. Go to NetScaler > NetScaler Gateway > NetScaler Gateway Virtual Server.

2% NetScaler VPX (500) i Logout

Dashboard Configuration Reporting Documentation Downloads

+ Syster NetSealer » NetScaler Gateway > NetScaler Gateway Virtual Servers [w] (7] |

&7

+ AppExpert
Add Edit Delete Statistics | | | Action - Search

+ Traffic Management :
Name State IP Address Port | Protocol Maximum Users Current Use
+ Optimization

_XD_TestGW @Up 192.168.18.22 a3 st 0

+ Security
= NetScaler Gateway

Global Settings
Virtual Servers

+ User Administration
KCD Accounts

+ Policies

2. Select _TestGW and click Edit.

3. Click No CA Certificate.

Basic Settings V4
Name _XD_TestGW Max Users 0 Double Hop false
IPAddress  192.168.18.22 Max Login Attempts Down State Flush true
Port 443 Failed Login Timeout AppFlow Logging false
State true ICA Proxy Session Migration false
CA Only false Enable Device Certificate false

Enable Authentication true

Certificates
1 Server Certificate >
No CA Certificate >

4. Click Bind.

CA Cert Key

CA Cert Key X

|- Bind |

Certificate Check Skip CA

No items

e
R

5. Select the CA certificate imported and click Insert.

CA Cert Key SSL Certificates

SSL Certificates x
‘ Install ‘ | Update ‘ | Delete | |;\\ction - ‘ Search ~
[] Name Days to Expire Status

Il p ns-server-certificate 4485  Valid

[l ) testgw.hopto.org 729  Valid

» VirtdomCA 2333 Valid
e '

6. Click Save.

Basic Settings Ve
Name _XD TestGW Max Users 0 Double Hop false
IPAddress  192.168.18.22 Max Login Attempts Down State Flush true
Port 443 Failed Login Timeout AppFlow Logging false
State true ICA Proxy Session Migration  false
ICA Only false Enable Device Certificate false

Enable Authentication true

https://support.citrix.com/article/CTX200287
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If you do not save after making changes to the NetScaler configuration, there is a risk that those changes will be lost when the

Certificates
1 Server Certificate

1 CA Certificate

Authentication

Primary Authentication

1 LDAP Policy

Published Applications

No Next HOP Server
1 STA Server

No Url

Policies

Request Policies
2 Session Policies

4 Cache Policies

Dane

2% NetScaler VPX (500)

Dashboard Configuration

+ System
+ Appxpert
=+ Traffic Management

+ Optimization

+ NetScaler Gateway

Show Unlicensed Features

Integrate with Citrix Products
4 XenMobile

&4 XenApp and XenDesktop

NetScaler reboots.

Back to top

StoreFront

DNS

Check that the DNS entries for the NetScaler Gateway Virtual Server (testgw.hopto.org) point to the correct place.

192.168.18.22

Back to top
StoreFront — Configuring a new installation

https://support.citrix.com/article/CTX200287

Reporting

MetScaler > System > System Information

System Information System Sessions

Upgrade Wizard | | Reboot

System Information

NetScaler IP Address

Statistics

Netmask 255.2

Node Stan

Time Zone GMT+(

System Time W,

Last Config Changed Time \Wed

Last Config Saved Time Wed,

Hardware Information

Platform  NetScaler Vi

Manufactured on ~ 2/17

cPU

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

7. Scroll down to the bottom of the screen and click Done.

Documentation

Logout

Downloads

)

8. Save your work to date by clicking on the Save icon on the upper right corner.

o]

e H

« On Internet - DNS needs to point to a public address that is accessible from the Internet. This will typically be a public address
on a firewall/router that is forwarded to the NetScaler Gateway Virtual Server IP

e On the private internal LAN — DNS needs to point to the local address of the NetScaler Gateway Virtual Server in the DMZ -

18/24
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1. Install StoreFront from your distribution media.

XenDesktop 7.6 Finish Installation

The installation completed successfully.
+ Licensing Agreement

«" Core Components Prerequisites

- +" Microsoft Internet Information Services Installed
v Firewall
v Summary Core Components

+ StoreFront Installed

« Install

n Post Install

Finish +" Component Initialization Initialized

(] Open the StoreFront Management Console

2. On completion, click Finish and open the StoreFront Management Console.

" Success

Select an option below to create a new store or extend your existing
deployment

Create a new deployment
Set up a deployment to deliver self-service applications, data, and desktops to your users.

Jain existing server group
Add a server to an existing load-balanced group.

3. When opened, the Management Console will notice that this is a new installation and will offer a choice of options.

4. Click Create a new deployment.

5. Accept the default Base URL and click Next.

Create Hew Deployment

StoreFront Create New Deployment

Confirm the base URL for services hosted on this deployment. For multiple server deployments, specify the
load-balanced URL for the server group.

Base URL

Store Name Base URL: | hitps://xenstored5.virtdom.chsys3.com

Delivery Controllers

Remote Access

N

2 aecsortiront 10| x|
File Acton View Hep
€= [E8E
Bl il
View 3
|G Refresh
Welcome to StoreFront @ s

6. Enter a store name of Store.

https://support.citrix.com/article/CTX200287

How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

(2 Callor Chat
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7. Click Next.

StoreFront SITALET
Choose a name that helps users identify the store. The store name appears in Citrix Receiver as part of the
user's account.
v Base URL
Store Name Store name: | stord

Delivery Controllers

Remote Access

8. Enter Delivery Controllers.

9. Click Next.

Delivery Controllers
StoreFront >
Specify the delivery controllers and servers for this store,
+ Base URL Delivery controllers:
" Store Name Name | Type | Servers
Delivery Controllers XenApp XenApp xenapp07.virtdom.chsys...
Remote Access XenDesktop XenDesktop xendde23 virtdom.chsys...

age.. || eat. || Remowe

10. Select No VPN tunnel.

Remote Access
StoreFront
Add NetScaler Gateway appliances to provide user access from external netwarks,
¥ Base URL Remate access: ) None
e @ No VPN tunnel @
« Delivery Controllers ~
v D) Full VPN tunnel @
Remote Access
NetScaler Gateway appliances: A
Add...
Default appliance: [ > ]

11. Add a NetScaler Gateway appliance.
12. Fill out the details of the NetScaler Gateway Appliance. Unless you have a complex environment, the Subnet IP address may be

left blank.

(2 Callor Chat

https://support.citrix.com/article/CTX200287 20/24
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13. Click Next.

Add NetScaler Gateway Applance

StoreFront General Settings
The display name is visioie ta users in Ctrix Receiver prefierences.

- Display name: [Tesow
Secure Ticket Authority r
NetScaler Gateway URL: | https//tesigw.hopto.ong
Versaon: [ 100 (Buia 694) or ister -
Subnet IP address:
{optional)
Logon type: | Domain -
-
Callback URL: @
hittps/ ftestgw nopto. ICrtrinAuth
(optional) ! EE gwnopto.orgd J ICrricduthSenice/AuthService.asmx

N -

14. Add a Secure Ticket Authority.

15. Ensure that any STA referenced here is also included in the NetScaler Gateway Virtual Server list of STAs.

16. Click Create.

Add NetScaler Gateway Appliance

StoreFront Secure Ticket Authority (STA)

Issues session tickets in response to application connection requests.

+ General Settings Secure Ticket Authority URLs:

Secure Ticket Authority http//xenappd7.virtdom.chsys3.com/scripts/cixsta.dl -

Z Enable session reliability

[ ] Requast tickets from two STAs, whers avalzble

17. There appears a warning symbol indicating that enabling remote access will automatically enable pass-through authentication
from the NetScaler Gateway. This is what is expected. Click Create.

Create Store

StOI’eFI’OI‘It Remote Access

Add NetScaler Gateway appliances to provide user access from external networks.

v Base URL Remote access: ) None

+ Store Name ®) No VPN tunnel @
«" Delivery Controllers

| ) Full VPN tunnel @
Remote Access

NetScaler Gateway appliances: | [#] TestGW r'y

Default appliance: [Temw = }

(2 CallorChat

https://support.citrix.com/article/CTX200287 21/24
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18. Click Finish.

Create Store E

StoreFront "Store" Created Successfully

Store available

Use email addresses for account discovery. Leamn more

Website created

Try out the store at https://xenstore05.virtdom.chsys3.com/Citrix/StoreWeb.

Back to top

Test the deployment from a Windows PC connected to the Internet
On the Windows PC

1. Confirm that a recent Citrix Receiver is installed.

2. Confirm that the Trusted Root CA Certificate has been installed into the Trusted Root Certification Authorities > Certificates
container.

ﬁ Consolel - [Console Root\Certificates (Local Computer)\Trusted Root Certification Authorities' Certificates]

5 File Action View Favorites Window Help

&< B0z HE

| Console Root Issued To Issued By Expiration Date *
4 m Certificates (Local Computer) [l VeriSign Individual Software Pu... VeriSign Individual Software Publi.. 31/12/1999
| Persanal .

08/01/2004
19/05/2018
02/08/2028
19/05/2018
02/08/2028

19/05/2018

a Trusted Root Certification Authorities

| Certificates
_| Enterprise Trust

| Intermediate Certification Authorities

| Trusted Publizhers

Untrusted Certificates

Third-Party Roet Certification Autherities

| Trusted People

| Remote Desktop

| Certificate Enrollment Requests
Smart Card Trusted Roots
Trusted Devices

4.J'.'sr\5|gn Individual Software Pu... VeriSign Individual Software Publi...

Cal VeriSign Trust Network VeriSign Trust Network

(] VeriSign Trust Network VeriSign Trust Network
Cal VeriSign Trust Netwerk VeriSign Trust Network
Cal VeriSign Trust Network VeriSign Trust Network

(3l VeriSign Trust Network VeriSign Trust Network

[l VeriSign Trust Netwark VeriSign Trust Network

{J';'EI'\E-IQH Trust Netwerk VeriSign Trust Network

(ol VeriSign Trust Network VeriSign Trust Network

[ VeriSign Universal Root Certific...  VeriSign Universal Root Certificati...

a4l Verizon Glebal Root CA Verizon Global Root CA

VI Reny ContsaciBoCCdBan [T, 7 - — P

Lglvirtdom-VIRTDCO1-CA virtdom-VIRTDCO1-CA 28/01/2021

3. Turn off certificate revocation checking in Internet Explorer. This is required because our private certificate server is unknown on
the Internet. a. Go to Internet Explorer > Internet Options > Advanced. b. Check for publisher’s certificate revocation = Off c.

Check for server certificate revocation = Off

4. If you use a browser other than Internet Explorer (such as Firefox) you might need to import the Trusted Root CA Certificate into
its Certificate Manager, and turn off Online Certificate Status Protocol checking.

CiTR!X' NetScaler Gateway

Welcome

Please log on to continue.

https://support.citrix.com/article/CTX200287 22/24
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How to Configure NetScaler Gateway to use with StoreFront 2.6 and XenDesktop 7.6

5. Use Internet Explorer to browse to your NetScaler Gateway. You should be presented with the NetScaler logon page.

Citrix Receiver

Desktops

6. When logged in you should be presented with the StoreFront page, and be able to launch Apps and Desktops.

Back to top

More How Do | Articles

Additional Resources

e (CTX202097 - How to Configure NetScaler 11 to use with Web Interface 5.4 and XenApp

e Click on the link to download the latest version of NetScaler Gateway

e Click on the link to download the latest version of XenDesktop

Was this page helpful?

View Common Solutions

Citrix ADC

Citrix Endpoint Management
Citrix SD-WAN

Citrix Virtual Apps and Desktops
ShareConnect

XenServer

Call Technical Support

1800 424 8749 (US)
0800 587 9031 (GB)
0800 182 5549 (DE)
0120941 133 (JA)

View Additional Numbers

https://support.citrix.com/article/CTX200287

Please provide article feedback.

Citrix App Layering
Citrix Gateway

Citrix SD-WAN WANOP
Citrix Virtual Desktops

ShareFile

Open a Case

Open a ticket online for technical
assistance with troubleshooting,
break-fix requests, and other product
issues.

Open a Case Online

Share this page

Citrix Application Delivery Management
Citrix Receiver

Citrix Virtual Apps

Citrix Workspace App

StoreFront

View Related Sites

Citrix Product Documentation

Citrix Discussions
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